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About this Documentation

Document Conventions
Convention Description
Bold Identifies elements on a screen.

Monospace font

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Italic

Identifies:

Variables for which you must supply values specific to your own situation or
environment.

New terms the first time they occur in the text.

References to other documentation sources.

Monospace font

Identifies:

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

Online Information and Support

Product Documentation

You can find the product documentation on our documentation website at https://documenta-
tion.softwareag.com.

In addition, you can also access the cloud product documentation via https://www.software-
ag.cloud. Navigate to the desired product and then, depending on your solution, go to “Developer
Center”, “User Center” or “Documentation”.

Product Training

You can find helpful product training material on our Learning Portal at https://knowledge.soft-

wareag.com.
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About this Documentation

Tech Community

You can collaborate with Software AG experts on our Tech Community website at https://tech-
community.softwareag.com. From here you can, for example:

® Browse through our vast knowledge base.

" Ask questions and find answers in our discussion forums.

Get the latest Software AG news and announcements.

Explore our communities.
® Go to our public GitHub and Docker repositories at https://github.com/softwareag and ht-
tps://hub.docker.com/publishers/softwareag and discover additional Software AG resources.

Product Support

Support for Software AG products is provided to licensed customers via our Empower Portal at
https://empower.softwareag.com. Many services on this portal require that you have an account.
If you do not yet have one, you can request it at https://empower.softwareag.com/register. Once
you have an account, you can, for example:

® Download products, updates and fixes.

® Search the Knowledge Center for technical information and tips.

" Subscribe to early warnings and critical alerts.

Open and update support incidents.

Add product feature requests.

Data Protection

Software AG products provide functionality with respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.
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Using the XML Mapping Editor

See also Using the EntireX XML Tester.

Starting the XML Mapping Editor

~ To start the XML Mapping Editor

In the Software AG Designer
= Double click on an XMM file.

Or:
Select an IDL or XMM file and choose Open With > EntireX XML Mapping Editor.

If the XMM file for the selected IDL file exists, the XML Mapping Editor loads this. The check
box Create a new mapping or overwrite the existing one for all programs and directions is
cleared. If you check the check box, you can choose the required mapping style and then press
Generate button to overwrite the existing mapping.

B ecample, xmm 22 = B 5% outline 2 5 F =0
L
= = ExAMPLE
Overview i iy
p .
+ General Information o Operation (AL} In
This section describes general information about this mapping: Cperand_1 (14) In

3 Operand_2 {I4) In

Software AG DL File:  Checlipse-50K-3.4, Z-win32\Workspace\ w1 _screensiexample.idl p Function Result (14) RESLLT

¥MM Mapping File: Cileclipse-50K-3.4, 2-win32\Workspace w81 _screens\example. <mm

=47 POWER

P
~ Mapping Parameters Cperand (14} In
Subset of available Mapping Parameters, To get the full list, Follow the Link below or choose the Mapping 3 Function_Result {14} RESULT
Pararieter page directly, 3-4P HeELo

p .
Marnespace URI: | urn:com-softwareag-entires-rpe: Sek-%p o Client (480} In

Mail (A30) InOut

Enable Mull Yalue Suppression (#30)

| Mapping Parameters Get the full lisk of Mapping Parameters

~ Mapping
Choose a mapping style.

Create a new mapping or overwrite the existing one for all programs and directions.

) Element () akkribube (5 304P () Custormized Generat

+ Teskting
Launch the XML Tester to test this mapping for XML/SOAP Listener:

+  Direct Test Call directly an RPC Server.

+ HTTP Test Call an RPC Server via the EntireX XML/SOAP Listener. Note: Requires deployed
AAR file.
+ Yalidation

Make all the available Walidity Checks in all Programs: Element Mames, Attribute Mames, validate the XML
Mode Properties, the %ML Mode Mapping, the encoding when using unicode data bypes, look for existing
Mamespace Prefix definitions used in xsi:bvpe attributes and inform about unmapped I0L Parts.

] validate Start the Validation

Owerview | XML Request | XML Response | Mapping Parameters | XML Samples
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Using the XML Mapping Editor

If no XMM file exists for the IDL file, the check box Create a new mapping or overwrite the
existing one for all programs and directions is checked the mapping style is set to "SOAP"

as default value. Choose the required mapping style and press Generate.

B ecample, xmm 22 = B | 5% outline 52 + =8
L
H = EXAMPLE
Overview
=P cac
p .
+ General Information o Operation (A1) In
This section describes general information about this mapping: o Operand_1 {14} In
Software &G DL File: Cileclipse-50K-3.4, Z-win32orkspacelyil \example.idl Operand 2 (I4) In
oftware ile: Cileclipse S, 2 orkspacevgl_screensiexample. i p Function_Result (14) RESULT
WM Mapping File: Cileclipse-3DK-3.4, 2-win 32\ Workspacew81 _screens!example, xmm 2P PowER
+ Mapping Parameters 3 Operand (14) In
Subset of available Mapping Parameters, To get the full list, Follow the Link below or choose the Mapping 3 Funckion_Result (14 RESULT
Parameter page directly, &P HELLD
p .
Mamespace URI: | urn:com-softwareag-entirex-rpc: %al-%p o Clienk (480} In
Mail (A30) InOut
Enable Mull Yalue Suppression (ASD)

| Mapping Parameters Gek the full lisk of Mapping Parameters

~ Mapping
Choose a mapping style.

[¥] Create a new mapping or overwrite the existing one for all programs and directions.
O Element O attribute @ s0ap O Customized

+ Teskting
Launch the XML Tester to test this mapping for XML/SOAP Listener
++ Direct Test Call directly an RPC Server.

+. HITP Test Call an RPC Server via the EntireX XML/SOAP Listener. Note: Requires deployed
AAR file.

+ Yalidation

Make all the available Yalidity Checks in all Programs: Element fames, Attribute Mames, validate the XML
Mode Properties, the XML Mode Mapping, the encoding when using unicode data bypes, look For existing
Mamespace Prefix definitions used in xsizkype attributes and inform about unmapped IDL Parts,

] walidate Start the Walidation

Crwepview | XML Request | ¥ML Response | Mapping Parameters | ¥ML Samples

Crwepview | XML Request | ¥ML Response | Mapping Parameters | ¥ML Samples

- To close the XML Mapping Editor

s From the File menu, choose Close.

Or:

Click the Close icon in the editor title bar.

If the current XML mapping has not yet been saved, a dialog box appears from which the close
operation can be stopped or the IDL- XML mapping can be saved. An XML mapping that is not

clean is indicated with a leading asterisk in the file name, displayed in the editor title.
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Using the XML Mapping Editor

The XML Mapping Editor Pages

= Qverview Page

= XML Request Page

= XML Response Page

= Mapping Parameters Page

= XML Sample Documents Page

Overview Page

The Overview Page is the central page and provides sections for file information, the most important
mapping parameters, mapping generation, testing and validation.
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Using the XML Mapping Editor

EEf Eample.xmmm - = B
Overview
+ General Information
This section describes general information abouk this mapping:
Software &G IDL File:  CHheclipse-30K-3.4, 2-win32\Workspacelvdl _screenstexample.idl
#MM Mapping File: Ceclipse-a0K-3. 4, 2-win32\WorkspacelwS1 _screens)example, xmm

+ Mapping Parameters

Subset of available Mapping Parameters, Ta get the Full list, Fallow the Link belaw ar chaose the Mapping
Parameter page directly,

Mamespace URI: | urnicom-safbwareag-entirex-rpe Sal-%p
Enable Mull Yalus Suppression

|EE Mapping Parameters Get the Full list of Mapping Parameters

* Mapping
Choose a mapping style.

/| Create a new mapping or overwrite the existing one for all programs and directions.
) Element ) attribute (%) 50aP () Customized

+ Testing

Launch the XML Tester to test this mapping for XML/SOAP Listener

-

Direct Test Call directly an RPC Server.

-

HTTP Test Call an RPC Server via the EntireX XML/SOAP Listener. Note: Requires deployed
AMR file,

+ Yalidation

Make all the available Yalidity Checks in all Programs: Element Mames, Attribute Mames, wvalidate the ®mML
Mode Properties, the XML Node Mapping, the encoding when using unicode data bypes, look for existing
Mamespace Prefix definitions used in xsikype attributes and inform about unmapped I0L Parts,

L] walidate Start the Walidation

Crverview | %ML Request | XML Response | Mapping Parameters | $ML Samples

These sections are:
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Using the XML Mapping Editor

* General Information
This section describes the names and locations of the selected XML mapping (XMM) file and
the related IDL file.

" Mapping Parameters
Provides the Namespace and Null Value Suppression controls and contains a link to the
Mapping Parameters Page.

| Note: Press Update Null Value Suppression to apply the mapping parameters (see
Mapping Parameters Page) to a generated mapping.

® Mapping
Starts the mapping generation for all programs.

| Note: Existing mappings will be overwritten!

* Testing
Allows you to launch the EntireX XML Tester in Quick mode or HTTP mode.

" Validation
Performs validity checks in all programs and reports the result in a new dialog. Detected problems
will be displaced in the Problems view.

XML Request Page

This page contains the Mapping tree of the XML Request, which is linked together by mapping
paths with the IDL tree in the Outline view.

|Em excample.xmm 53 = O 5= outlire 52 cl =

o @ ExaMPLE
XML Request = P caLe

3 Operakion (A1) In

A p Cperand_1 (I4) In
= [8] SOAP-EMY:Envelaope P operand_2 (1) In
=I-[e] SOAR-ENY:Header P Function_Result (I14) RESULT
[e] soaPaction [idprog: CALC ] 5P powER
=l [&] SCAP-EMY:Body ¥ operand (141 In
=-[8] miCaLC [idlprag: CALC ] ® Function_Result {14 RESULT
e8] Qperation [idlsCALC J Operation ] J-2P Hewo
[B§ operand_1 [ idl:CALC f Operand_1 ] P Client {A50) In
[8] Operand_2 [idiCalC [ Operand_2 ] P ail (A507 InCut

Overview | XML Reguest | XML Response | Mapping Parameters | XML Samples
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Using the XML Mapping Editor

The XML Request shows the XML tree loaded or created so far for the selected IDL program. The

XML tree can be modified in various ways. See IDL to XML Mapping with the XML Mapping

Editor.

The Outline view shows the IDL tree of the currently selected IDL file. The IDL tree display has

the same functionality as the IDL Editor's tree display; however, due to the fact that every IDL

program must be separately mapped, only one of the IDL program tree nodes can be expanded.

Use the right mouse button to display the context menu. Double-click on a tree node to display
detailed information on that node. The following keyboard options are also available in the XML
request mapping area:

Key

Description

A or SHIFT+INS

Create new parameter node after currently selected one.

D or DELETE

Delete the selected IDL tree node.

F

Find IDL node with given name pattern.

I or ALT+INS

Create a new group parameter node.

L Create new IDL library node.

M Find mapped XML node for selected IDL tree node.
N or INS Create new parameter node.

O or CTRL+INS |Create new RPC program node.

P or ALT+ENTER

Open property dialog on selected IDL tree node.

R Rename the selected IDL tree node.
F3 Follow-up of M, find next mapped XML node for selected IDL tree node.
XML Node Properties Dialog

The XML Node Properties dialog contains the XML node details, the bottom panel contains

namespace settings.

EntireX XML Mapping Editor
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Using the XML Mapping Editor

XML Mapping Editor

*»ML Node Froperties
Properties of Operation [ idl:CALC [ Operation ]

Elerment Mame:

Mapped to: CALC | Operation

Progranm Mapping: Mo |~
Farrak: skring |
Locale for Date/DateTime: |~

Yalue Length: | 1
Mull Value Suppression: IN::: SUppression j
Mim, CCCUrrEnce; I 1 Mazx, CCcurrence: I 1
Default Value: I j
Millable: [
Mamespace Prefix: |
Default URI: |
Table of defined Mamespace definitions:
Prefixz =~ Mamespace Default Insert, ..
Edit. ..
Remove
Default

® QK Cancel

~ To open the XML Node Properties Dialog

= Double-click on an XML node in the tree display.
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Using the XML Mapping Editor

Or:
Choose the Properties menu item in the context menus.
Or:
Select an XML tree node and press Enter.
The XML Node Properties can be modified. The node details panel consists of two subpanels.

The upper panel contains the following:

Item Description
Element or Name of the element or attribute.
attribute name
Mapped to The IDL mapping link in the full path name format. For error (fault) trees, context
information.
Program Mapping | Combo Box
No No program Mapping.
Element value The value of this node identifies the program.
Element name The name of this node identifies the program.
Format
string A, AV, K, KV
- G
I1 (deprecated) 11
12 (deprecated) 12
14 (deprecated) 14
I8 (deprecated) 14
integer 11,12, 14
date D
time (deprecated) T
dateTime T
float F4, F8
Boolean L
binary B, BV
number N, P NU, PU
For Tamino/special nodes: Describes the data type of the Tamino node (for example,
integer, string).
Locale for Set language used for Date/DateTime format depending on pattern. For example,
Date/DateTime  |pattern yyyy-MMM-dd with locale=English is shown as 20-Dec-2017, and

EntireX XML Mapping Editor 13



Using the XML Mapping Editor

ltem

Description

locale=German as 20-Dez-2017. If the default "-" is specified, the value of the current
JVM is used.

Value Length

The length parameter contains the length or precision of the data type, that is,

B length of string for alphanumeric

length of field in bytes for binary

length of string representation for floating point

length of string representation for integers

length of string for Kanji

length of bit vector for logical (Boolean)

Length V is legal for string types. It denotes variable-length strings, e.g. alphanumeric
or Kanji.

For Tamino/special nodes: Length of the storage reserved for the data must match
format.

Default Value

Must match the data type of the node, e.g. do not use alphanumeric defaults for integer
nodes. Defaults that cannot be interpreted by the runtime component are ignored. See
also Assigning Default Values.

Namespace Prefix

Contains the namespace prefix to the tag name.

Min. Occurrence

The minimum and maximum occurrence properties are numeric values greater than
or equal to zero. They describe the number of allowed occurrences of the node in the
incoming XML, and the number of occurrences to be generated in the outgoing XML.
The minimum occurrences value must be less than or equal to the maximum occurrences
value. Incorrect settings will be found in the validity check Validate XML node
properties. If Min. Occurrence is greater than 0 for incoming documents, the
corresponding attribute or element is required, that is, it must be set.

Max. Occurrence

See Min. Occurrence.

Null Value
Suppression (NVS)

Specify suppression of null values (NVS), that is, whether empty elements or attributes
may be omitted in the outgoing (generated) XML documents. Mainly determined by
Min.Occurrences and Max. Occurrences as follows:

® For min =0, max =0, there is no NVS.

® For min =0, max = 1, the element / attribute may be omitted if empty.

= For min =0, max > 1, you can omit all empty elements or just omit empty elements
at the end of the sequence (trimming).

® For min =1, max =1, there is no NVS.

= For min =1, max > 1, you can omit all empty elements or just omit empty elements
at the end of the sequence (trimming).

® For 0 < min < max, you can omit all empty elements or just omit empty elements at
the end of the sequence (trimming).

14
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Using the XML Mapping Editor

Item Description
It is also possible to suppress an attribute (independent of its value) if the associated
element has a null value and null value suppression is enabled; to do this choose
Depends on element in property Null Value Suppression.
For the data types, the following null values are defined:
Format NVS Default
string "" (empty string)
- "" (empty string)
I1 (deprecated) 0
I2 (deprecated) 0
14 (deprecated) O
integer 0
date
time (deprecated)
dateTime
float 0.0
Boolean false
binary Only BV with length =0; Only binaries corresponding to IDL
parameter with type BV have an NVS default [element/attribute
with data length=0].
number 0.0
Null Value If NVS is switched on, this value is compared with the values of the XML document
and it is decided whether the values need to be transmitted. The defaults are in the
table for NullValue Suppression (NVS).
Nillable If NVS is set to "No Suppression", the Nillable option is available in the dialog. If the

option is selected, an empty element is represented as an empty-element tag with
attribute xsi:ni1="true". This means that if a nillable group element only has elements
without value and without attributes, only the enclosing group tag with attribute
xsi:nil="true" is displayed.

Time Pattern

Optional for date, time (deprecated) and dateTime.
The default patterns conform to the XSD Schema 2001 specification:

date: yyyy-MM-dd, for example 2003-04-15
dateTime: yyyy-MM-dd'T'HH:mm:ss, for example 2003-04-15T18:48:23

If you want to define your own time pattern (for example with "Day in week" or "General
Time Zone"), see the Java documentation for SimpleDateFormat.

EntireX XML Mapping Editor 15



Using the XML Mapping Editor

Correlation of Occurrence Setting and Null Value Suppression

The value for null value suppression has a higher priority than the occurrence setting of affected
elements or attributes. The following rules apply:

1. NVS="Suppress Element"/"Suppress Attribute"
Setting NVS to Suppress Element" or "Suppress Attribute" results in a value of minimum occur-
rence of zero, which makes it optional.

2. NVS="No Suppression”
Setting NVS to "No Suppression” means that the element/attribute is always displayed so the
value of #minOccur must be 1 - otherwise the element/attribute would be optional and could
be suppressed.

3. NVS for arrays
For arrays, the dependency of minimum occurrence and Null Value Suppression is more com-

plex:
a. NVS set to "No Suppression”
For an array with fixed size the setting is #minOccur = #maxOccur = farray size.
An array with variable size will contain all non-suppressable elements, but at least #minOccur

elements. Empty elements will be generated to guarantee the number of #minOccur.

b. NVS set to value other than "No Suppression”
The number of array elements is at least #minOccur (empty elements will be generate and
appended if number of elements is lower than #minOccur).

The lower panel is only available for element nodes and contains namespace-related properties:

ltem Description

Namespace URI A default Namespace (xmlns=.....) for this element node.

Namespace definitions A table of namespace prefix / URI assignments for this element node. The

(table) listed namespaces are defined for this element and all subelements, as described
in the XML namespaces specification document. Two buttons, Add and Delete,
allow you to add or delete namespace definitions, respectively.

Using the Context Menu
The context menu of the XML tree enables you to modify the XML structure. It contains menu
items to insert new nodes, remove or rename nodes, remove an IDL mapping, change the XML

part type to element or attribute, move the selected node to the top or bottom of the current subtree,
move the selected node up or down within the subtree, or show the XML Node Properties dialog.

~ To open the context menu

= Select the XML tree node and click the right mouse button.
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Using the XML Mapping Editor

Menu Item Shortkey Description

New child node|Ctrl-N Insert a child node under the selected node.

Insert before  |Ctrl-B Insert a new node before the selected node.

Insert after Insert Insert a new node after the selected node.

Set to Attribute |Ctr1-S Turn an attribute into an element. Also works for multiple selected nodes.

Set to Element |Ctrl-E Turn an element into an attribute. Also works for multiple selected nodes.

Bring to top Ctrl-T Move the selected node to the top of the current subtree.

Bring to bottom |Ctrl-O Move the selected node to the bottom of the current subtree.

Move up Ctrl-U Move the selected node up within the subtree.

Move down Ctrl-D Move the selected node down within the subtree.

Cut Ctrl-X Cut the selected node.

Copy Ctrl-C Copy the selected node.

Paste Ctrl-V,Ctrl-P Paste a node from the clipboard (after copy or cut).

Unmap Ctrl-M Unmap the selected IDL and XML nodes, i.e, remove link. Also works for
multiple selected nodes.

Delete Delete/Backspace | Remove the selected node. Also works for multiple selected nodes.

Rename Ctrl-R Rename the selected node.

Properties Alt-Enter Open the XML Details Panel.

Using Drag-and-drop

You can use drag-and-drop operations within the XML tree instead of move and cut-and-paste.
Select a node (even with subnodes) and drag it to another place. The dragged subtree is then in-
serted after, before or under the corresponding drop node (to insert it under the drop node, use
the ctrl key as a toggle).

Some drag-and-drop operations are illegal, e.g. dragging a node into one of its descendant nodes
(children). This would result in a cyclic reference and is thus forbidden.

Dropping a dragged node into an attribute node will convert the attribute node to an element
node. This is because attributes may not have descendant nodes.

w

Caution: If you drag a subtree into or out of an array, the IDL mapping links of all nodes of

that subtree will be deleted. This is because the cardinality of the node occurrence has
changed, and the resulting IDL mapping is very likely to be incorrect.

EntireX XML Mapping Editor

17



Using the XML Mapping Editor

Drag-and-drop from an IDL Tree Node to the XML Tree

If you drag an IDL tree node onto an XML tree node, the IDL-XML mapping link for that XML
node is changed. The new XML-IDL mapping of this XML tree node is to the dragged IDL node.
The IDL tree is not changed.

This is a quick way to change IDL mappings for XML parts. Note that there is no immediate check
for duplicate assignment of an IDL node; however, the validity checks will detect it.

XML Response Page
This page contains the Mapping Tree of the XML Response, which is linked together by mapping

paths with the IDL tree in the Outline View. The page extends the XML Request page with an
additional section, Fault Document Manager, at the bottom.

@example.xmm 23 =g EE Outline 23 2 F — 8
L
= ExAMPLE
XML Response = oP caLc

F Cperation (A1) In

Mapping p Cperand_1 (I4) In
= [e] SoaP-EMY:Envelope ¥ operand_z (14 In
[€] SOAP-ENY:Header " Function_Result {14} RESULT
=-[€] SOBP-ENY:Bady =-4F powER

=-[8] m:CALCResponse [ idlprog: CALC ] P operand (141 In
[IERFunction_Result [ idl:CALC f Function_Resulk ] P Function_Result (147 RESULT
=" HELLO
P Client (A&0) In
P mail (4800 InCut

» Fault Document Manager

Crverview | XML Request | XML Response | Mapping Parameters | %ML Samples

The Fault Document Manager contains the entry for the XML Fault Response Document. By select-
ing the entry, the Edit... button will be enabled. Press Edit... to display the following dialog:
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& EntireX XML Mapping Editor

Fault Response

Mapping

SOAP-EMY:Envelope
(8] soaP-EMY:Header
=[] SOAP-ENY:Body

=-[8] SoAP-EMV:Fault [idlprog: CALC ]
[g] Faultcade [ info:Faultcode ]
[8] Faultstring [ info:Faultstring ]
[8] Faultactor [ info:Faultackar ]
[8] detail [ inFo:detail

Ik ] [ Cancel

The same operations as for the XML Request and XML Response trees are possible. Confirm the
changes with OK, or click Cancel to exit without changes.

Mapping Parameters Page
This page covers the Mapping Parameters to affect the Mapping Structure. The default values for

that page will be managed in the preferences and can be loaded by using the Restore Defaults
button in the upper right corner.
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Mapping Parameters

Restore Defaulks

The mapping parameters can only be used for generating a new IDL-%ML mapping.
Just changing mapping paraneters has no effect on an existing mapping; generate the mapping again For the changes to take effect.

+ Document Style
Generakte Array Envelope Element

WSOL Skvle: | document/liceral
+ Encoding Settings

#ML Default Encoding: | UTF-8
|:| Use incoming Encoding

+ Mull ¥alue Suppression

Caontral empty elements or attributes may be omitted in the XML documents,

Enable Mull Value Suppression

Siniple Elerment: | Mo Suppression
Simiple Attribute: | Mo Suppression
Array Types: Cells at End (Trim)

Camplex Types:

Suppress Group Elements

Suppress Attributes, if Element has Mull value

+ Mamespace Definitions
Table of defined Mamespace definitions:

Prefix
SOAP-EMNY
wsd
m
SOAP-ENC
x5

Marnespace

Defaulk

http:/fschemas. xmisoap, orgfsoapfenvelope!
hikbpe e w3, org 2001 XML Chema
urn:com-sofbwareag-entiresx-rpc: %l
http:/fschemas. xmisoap, orgfsoap/encoding,
hikbpe: e w3, org 2001 XML Cchema-instance

(default)

Overview | ¥ML Request | %ML Response | Mapping Parameters | XML Samples

Parameter

Description

Generate Array Envelope
Element

Determines whether for each array a surrounding additional element
(envelope) is generated or not.

WSDL Style Prepare the SOAP Mapping for selected WSDL Style. Possible values:
document/literal or RPC/encoded.
XML Default Encoding This encoding is used for the XML/SOAP document sent if the box Use

incoming encoding is not checked (for XML-based clients), or if the RPC
Server for XML/SOAP is used.

Use Incoming Encoding

Check this box to enable the XML/SOAP Wrapper to use same encoding
for the incoming document as for the outgoing document.

Enable Null Value Suppression

(O]

Switch on/off the null value suppression.”

Simple Element™

Suppress Elements. Possible Values: No Suppression or Suppress
Element."”

Simple Attribute'”

Suppress Attributes. Possible Values: No Suppression or Suppress
Attribute.”

20
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Parameter Description

Array Types"” Suppress Array Types. Possible Values: No Suppression, All empty cells
or Cells at end (Trim)."”

Complex Types"” Suppress Complex Types. Possible Values: No Suppression Suppression
(no special handling of complex types - null value suppression defined
for 'Simple Element' is used), or Suppress Group Elements.”

Namespace Definitions Table ~ |Manage all Namespaces with prefix and URL

@ For more details on null value suppression, see below or Null Value Suppression under Writing
Advanced Applications with the XML/SOAP Wrapper.

XML Sample Documents Page

This page allows the generation and modification of XML Sample Documents. They can be used
to test the Mapping by sending the generated Request Document to the EntireX XML Tester. An-
other useful point is to compare the XML Sample Document structure with the real XML Document
returned by your application to detect differences, for example Namespace Definitions, typos or
anything else.

B examnple . smm 52 = B
XML Sample Documents B
DL ML Documents
= @" ExAMPLE <txml wersion="1.0" encoding="UTF-&" =
= @P CALC <l-- Generated by Software 4G, Entires XML Mapping Edito

<50AP-ENY: Envelope xmins: SO8P-ERN="http: [ lschemas, xr
Reguest Document ZSOAP-EMNY: Header =
|=| Response Docurnent l-- SSOAPACkion = CALC < S0APAckion s -- =
<S0AP-ENY  Header =
QP POWER “S0AP-ENY:Body =
QP HELLO = CALEC xmins:m="urn:com-sofbwareag-entirex-rpcEx
<Cperation =M< Operation =
“0perand_1 =-1686024913 </ Operand_1 =
“0perand_2 =-1252560089 </ Operand_2 =
“imiZalC =
<}SOAP-ENY:Body =
= [S0AP-EMY  Envelope =

£ >
Cryerview | XML Request | <ML Response | Mapping Parameters | <ML Samples
All generated XML Sample Documents can be stored in parallel to the selected XMM file by using

the Save All toolbar button in the upper right corner of this page or the Save command in the
context menu. The generated file name is built as follows:

EntireX XML Mapping Editor 21



Using the XML Mapping Editor

[xmm name] .[library namel.[program name].[direction (request | response)].xm]
For example: example.EXAMPLE.CALC.request.xml

If a file already exists, a dialog will prompt you for confirmation to overwrite it.

Using the Context Menu of XML Samples

The XML Samples context menu allows the generation of XML Sample Documents.

There are two different menus:

® Library or Program is selected

izenerate 4l

Eequest

Save Fesponse

Generate All means both directions (Request and Response). When a Library is selected, the
commands here will be inherited by all Programs.

* Request or Response Document is selected

Generate
Delete

“ML Tester., .,
Save

The EntireX XML Tester... command sends the selected XML Sample Document to the EntireX
XML Tester as Direct Test and enters the name of the XMM file.

XML Schema Export

The current XML Mapping can be exported as XML Schema, using the context menu of the XMM
file. The XML Schema style "Russian Doll" or "Venetian Blind" can be selected in the preferences.
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(8 Parkag &3 T Hierarc | — O
==
= 1= Demo
# src
B, IRE Swstem Library [jren]
@,! excample.idl
@ﬂ example, xmm
M k

Dpen F3
Cpen \With »
Show In Alb+Shift+i #

oy Chel+C
opy Qualified Mame
aske Chrl+Y

Co
Zo
5 Pa
Delete Delete

ﬁ tnt ﬂl IIIII

Eiild Path k
Refactar alk+shife+T

-

£y Import,..
L7 Export...

q;,** Refresh F5
Assign Warking Sets. ..

Test Joftware &G 5MLISOAP mapping

zenerate #ML Schema (xS0

Generate Web Service from Entire Mapping ...
Deploy to Entirex XML/SCAP RPC Server...
Fun As

Debug As

Team

Compare With

Feplace With

v ¥ v v v

Properties Alt+Enter

The generated XML Schema files will be stored in parallel to the selected XMM file, where one
file represents the direction (request or response) and the defined prefixed element.

For example: a SOAP mapping creates four files from the example CALC program: two prefixes
("SOAP-ENV" and "m"), and two directions (request and response). The generated file name is
built as follows.

[xmm namel.[1ibrary namel.[program namel.[direction (request |
response) ][ (optional).additional prefix].xsd
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Example

® example. EXAMPLE.CALC.request.xsd

® example. EXAMPLE.CALC.request.m.xsd
® example. EXAMPLE.CALC.response.xsd

* example. EXAMPLE.CALC.response.m.xsd

If a file already exists, a dialog will prompt you for confirmation to overwrite it.
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XML Mapping Editor Settings

The preference page XML Mapping Editor manages the default values.
For XML Schema the style "Russian Doll" or "Venetian Blind" can be selected.

All other parameters are described under Mapping Parameters.

& Preferences l S] |-

type filter text XML Mapping Editor =T v
‘ Sof'b:\fare AG 1 Store Settings for XML Mapping and XML 5chema Generation.
» Ajax Developer
API-Portal Document Setting | Mamespaces | Mull Value Suppression | XML Schema Generation |_
» Business Services XML Schema Generation
» Code Generation XML Schema Style
» Construct @ Russian Doll () Venetian Blind
Document Expansion
4 EntireX
> COBOL 3
Integration Servers 1
> Matural
- PLI

4 Web Services
RPC Environments for RPC &
Web Service Wrapper
XML Mapping Editor
» Wrappers
Dotonee LT--l- [ Restore Defaultsl ’ Apply ]

@' (éj [ 0K ] ’ Cancel ]

Removing Unused Namespaces

~ To remove one or more unused namespaces

1 Open the XML Mapping Editor for the XMM file.
2 Select tab XML Request.
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3
4

e example.xmm - 53

XML Request

Mapping

SRS AP-ENY:Envelope
=-[8] SomP-EMY:Header
(8] soaPaction [idlprog: CALC ]
=[] SOaP-ENY:Body
= [8] m:CaLC [ idlprog: CALC ]
(8] Operation [idhCALC | Operation ]
2] Operandl [idhCalC ) Operandl ]
2] Operand2 [idhCalC | Operand2 ]

Overview mML Request TEML Respanse | Mapping Parameters | ML Samples

Select the element that defines namespace(s) to be removed.

From the context menu, choose Properties.
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XML Mapping Editor

XML Node Properties
Properties of SO8P-EMY:Envelope

Element Marme: | Envelope

Mapped ko “Mone = I
Pragram Mapping: Mo

Format: -

L Led L

Locale For Date/DateTime;

Walue Lemngth: | W (wariable)
rull Yalue Suppression: INEI SUppression j
Miry, ECCUrrEnze: I 1 M, CICCUrrentce: I 1
Defaulk Yalue: I j
Millable: r
Mamespace Prefix; | SOAP-EMNY
Diefault URI: |
Table of defined Mamespace definitions:
Prefix = | Mamespace | Drefaulk | Insert. ..
SORP-EMC htkp: ffschemas, xmlsoap, org)soapencoding :
SoEP-ENY http: [ ischemas, xmlsoap. orgfsoapfenvelope) Edit, ..
XTI http:finamespace. softwareag, comjentires: xml, .. REmove
wsd hikkps f sy 3, arg 2001 fEMLSchema
%5 htkp: | fenens w3, org) 2001 fXMLSchema-instance Default

® (0] Cancel

5  Select (unused) namespace entry/entries in list and choose Remove.

6  Press OK.
7  Repeat these steps for the XML response (select the XML Response tab and repeat the steps
above).

EntireX XML Mapping Editor 27



Using the XML Mapping Editor

8 Save the XMM file.
9  Switch to XML Samples tab, which shows the following:
BT earnple.xmm 5 =0
XML Sample Documents B
IDL ZML Documents
= @" ExAMPLE <7eml wersion="1.0" encading="UTF-3" *>=
= ®P CALC «|-- Generaked by Software AG, Entirel XML Mapping Edito
- <R0AP-ENY:Envelope xmins:30AP-ENY="http: /lschemas, xr
[SRF.2quest Document 250AP-ENY  Header =
|= Response Docurment < l-- SSOAPACkon = CALC </ S0aPAckion > -- >
</S0AP-EMY  Header =
b j POWER SA0AP-EMY Body =
HELLO =mCALC wminsm="urn: com-sofbwareag-entirex-rpo: Ex
< 0peration=M-=Operation =
20perand_1 =-1686024913 </ 0perand_1 =
i0perand_2=-1252560089 < Cperand_2 =
< I CALC =
< [S0BP-EMY Body =
< [S08P-ERY  Envelope =
< | >
Cverview | XML Request | XML Response | Mapping Parameters | %ML Samples
10 The XMM file defines the following:
<FromXml>
{Method relatedIdlLibrary="EXAMPLE" relatedIdIProgram="CALC" encoding="UTF-8"
useIncomingEncoding="true">
<XmINode name="Envelope" length="0" min="1" max="1" namespacePrefix="SOAP-ENV"
nullSuppression="NVS_NONE" nullValue="" >
<XmlNamespaceDef <«
prefix="SOAP-ENV" uri="http://schemas.xmlsoap.org/soap/envelope/"/>
<XmlNamespaceDef <«
prefix="SOAP-ENC" uri="http://schemas.xmlsoap.org/soap/encoding/"/>
<XmINode name="Header" Tength="0" min="1" max="1" namespacePrefix="SOAP-ENV"
nullSuppression="NVS_NONE" nullValue="" >
<XmlNode name="SOAPAction" format="string" type="xsd:string" lTength="0" min="1" <
max=ll1ll
default="CALC" nullSuppression="NVS_NONE" nullValue="" programNode="ev" >
</XmlNode>
28 EntireX XML Mapping Editor



3

EntireX XML Tester

Introduction to the EntireX XML Tester

EntireX XML Tester Options .............
Using the EntireX XML Tester ...........

Using the Broker and RPC USEr ID/PASSWOIG ............cciiiuiiiiiiiiiiiiiiiii et

Using Conversational RPC ...............

29



EntireX XML Tester

Introduction to the EntireX XML Tester

Using the EntireX XML Tester you can send an XML document to the EntireX Listener for
XML/SOAP.

The EntireX XML Tester supports drag-and-drop editing, and you can restore the last used session
within a workspace. If the mapping file has changed, the views for request and response are
cleared.

The EntireX XML Tester is provided by the Designer as an Eclipse View and can be opened from
the XML Mapping Editor or XML/SOAP Wrapper. It is also accessible from Windows > Show
View > Other... > Software AG > XML Tester. The following test modes are available:

® Direct Test (Using the Java Interface)
= HTTP Test (Using the EntireX Listener for XML/SOAP)

See sample screen and description of options below.

= Tasks KMLTester bcs RPC Envirenment Menitor Entire}(DefauIthker B 1s = O

= Target and Environment Area

@ HTTP Test (XML/SOAP Listener) HTTP URL  http://localhost10010/ wsstack/services -
©) Direct Test XMM or AAR File: -
Input XML Document:
Document Area (Request and Response) [l":7l-I
Tree View | Text View | Raw View
<%ml version="1.0" encoding="UTF-8" 7> -

<!-- Generated by Software AG, EntireX XML Mapping Editor (10.5.0.0) on 2018-11-21 at 08:22:53 --»
<m:CALC xmins:m="urn:com-softwareag-entirex-rpc EXAMPLE-CALC" =
<Operation>+</Operation>
<Operandl > 21 </Operandl »
<Operand2>6</0perand2>
</miCALC> B

m

1

4 P

Tree View | Text View | Raw View

30 EntireX XML Mapping Editor



EntireX XML Tester

EntireX XML Tester Options

= Table of Values

= Direct Test Details Dialog

= EntireX/HTTP/HTTPS Parameters Dialog
= Add Parameter Dialog

= Edit Parameter Dialog

Table of Values

Name Type Description

Direct Test Check box Check this box to test the Java interface of the XML/SOAP Runtime.
If checked, the Settings action will open the Direct Test Details
dialog.

XMM or AAR File | Text field The AAR file, which contains one or more mapping files (XMM files),
or the XMM file, which contains the mapping information. Accept
absolute path.

If the file does not exist, the action Create Sample XML... is disabled.
When the file is found, the Broker ID and Server Address are read
and the corresponding fields in the Direct Test Details dialog are
filled.

If a corresponding WSDL file within a definition of EntireX parameters
is found, the EntireX parameters are added to the EntireX parameters
setting and the URI is set.

Combo box Behavior depends on content of field XMM or AAR File:

= If this field contains an AAR file, this combo is enabled and filled
with all the mappings stored in the archive. Select the mapping
you want from the list.

= If this field contains an XMM file, the combo box is disabled.

Browse... Button Open a File open dialog to select the XMM or AAR file from the file
system.
HTTP Test Check box Check this box to test the HTTP interface (EntireX Listener for

XML/SOAP) of the XML/SOAP Runtime. If checked, the Settings
action will open the EntireX’HTTP/HTTPS Parameters dialog.

HTTP URI to Combo box URI of the EntireX Listener for XML/SOAP. Will store the last ten

contact called URLs.

Input XML Text field File name of the XML Document to be sent.

Document to send

Browse... Button Open a File open dialog to select the XML Document file from the
file system.

EntireX XML Mapping Editor 31



EntireX XML Tester

Name Type Description
Create Sample Action B Open the Create Sample XML... dialog, see below. If the text file for
XML... the XMM file does not contain a valid file path, the Create Sample
XML... button is disabled.
input - area Tree/Text/Raw Input field for the XML data to be sent to the Broker, this area is filled
view with the text/tree representation of the selected file, see Input XML
Document to send. If empty, the Play action is disabled.
output - area Tree/Text/Raw  |Output field for the XML data response from the Broker. By default,
view the response will be displayed in platform encoding. But if the XML
data request contains a valid encoding in the XML declaration, this
encoding will be used and a tooltip text will inform you of this. This
view will also display the status and errors.
Settings Action E Open either Direct Test Details or EntireX/HTTP/HTTPS Parameters
dialog. See Direct Test and HTTP Test above.
Play/Stop Action  / H Start/stop the test. This action is disabled if there is no text in the
input - area.
Reset Action 1@ Reset the input and output areas.

Direct Test Details Dialog

Use the Direct Test Details dialog to change the Direct Test parameters. The Broker ID, Server
Address, the Security Settings, the Natural Settings can be modified for this EntireX XML Tester
session. Compression Level is a non-editable box that contains all possible values. Broker ID and
Server Address are editable dialog boxes and hold the last five used values. Use the Reliable RPC
check box to turn reliable messaging on or off (mode is AUTO-COMMIT). See Reliable RPC.

= XML Tester

==

Direct Test Details
Define Direct Test parameters.

Main | Broker Securityl Naturall

Broker ID: localhost:1971

Server Address:

RPC/SRV1/CALLMNAT

Compression Level:

[T Use Codepage

I [ Reliable RPC (auto-commit)

OK ] ’ Cancel

32

EntireX XML Mapping Editor



EntireX XML Tester

EntireX/HTTP/HTTPS Parameters Dialog

This dialog contains the following tabs:

= EntireX Parameters
= HTTP Headers
= HTTPS Parameters

EntireX Parameters

With the EntireX Parameters tab you can add more EntireX-related information for the call. An
entry must be selected to be active. The Value box holds the last five used values or the predefined
values for the corresponding property. It is editable, which means you can change a value by
clicking directly in the table. EntireX parameters can be added to the request XML/SOAP document
(default) or as HTTP header entries.

& XML Tester 4

EntireX/HTTP/HTTPS Parameters E
Manage EntireX/HTTP/HTTPS Parameters

EntireX Parameters HTTP Headers HTTPS Parameters

Key Value Add...
exx-brokerlD localhost: 1971 Edit
exxK-service RPC/SRV1/CALLNAT
Remove
Select A
Deselect All

Add EntireX Parameters to
® SOAP/ XML Reguest Document (O HTTP Header

oK Cancel
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HTTP Headers

With the HTTP Headers tab you can add more information for the call and set the SOAPAction.
An entry must be selected to be active. The Value box holds the last five used values for the cor-
responding property. It is editable, which means you can change a value by clicking directly in
the table.

& XML Tester >
EntireX/HTTP/HTTPS Parameters
Manage EntireX/HTTP/HTTPS Parameters
EntireX Parameters HTTP Headers HTTPS Parameters
Key Value Add...
SOAPAction CALC :
Edit...
Remove
Select Al
Deselect All
OK Cancel
HTTPS Parameters

With the HTTPS Parameters tab you can set parameters required for an HTTPS connection. An
entry must be selected to be active. The Value box holds the last five used values or the predefined
values for the corresponding property. It is editable, which means you can change a value by
clicking directly in the table.
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£ XML Tester *

EntireX/HTTP/HTTPS Parameters E
Manage EntireX/HTTP/HTTPS Parameters

EntireX Parameters HTTP Headers HTTPS Parameters

Key Value Add...
javaxnetssl trustStore Cpathtomuststors .
V] javaxnetssltrustStorePassword  [fUStStoreibasswermm =
Remove
Select All
leselect A
0K Cancel

Add Parameter Dialog

With the Add dialog you can add a new EntireX, HTTP or HTTPS parameter. All Software AG's
predefined parameters are listed in the Key box. A validation runs on the value of a predefined
parameter.

Edit Parameter Dialog
With the Edit dialog you can change the value of a property. The Value box is editable and holds

the last five used values. The Key value for all predefined properties cannot be modified. A valid-
ation runs on the value of a predefined parameter.
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S XML Tester X

Add new EntireX Parameter E

Define key and value for the EntireX Parameter.

Key:
Value: | RPC/SRV1/CALLNAT ‘

'f?:' OK Cancel

exx-service w

Using the EntireX XML Tester

Using the EntireX XML Tester you can send an XML document to the EntireX Listener for
XML/SOAP.

~ To open the EntireX XML Tester

In perspectives other than EntireX, choose Window > Show View > EntireX XML Tester, in
other perspectives, choose Window > Show View > Other ... > Software AG > XML Tester.

Or:

Choose Window > Open Perspective > Other... and select EntireX Perspective. The EntireX
XML Tester view is part of this perspective.

Or:

In the XML Mapping Editor, switch to the Overview page, choose Direct Test or HTTP Test
in the testing section.

Or:

In the XML Mapping Editor, switch to page XML Samples, select one document, choose En-
tireX XML Tester in the context menu.
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> Torun a test

1  Load the mapping information. In field XMM or AAR File, enter the absolute path to the
AAR or XMM file that is being tested (you can use the Browse... button or a drag-and-drop
operation). If you enter an AAR file, all mappings contained in the archive are listed in the
combo box next to the XMM or AAR File field.

@ HTTP Test (XML/SOAP Listener) HTTP URL  http://localhost10010/ wsstack/services -
) Direct Test HMM or AAR File:  D:vworkspaceimoreXmm.aar -- lnamawcmm "] | Browse... |
names.xmm
Input XML Document: g
countries.xmm 4

2 Select the testing interface (Java or HTTP):

= Java interface: the XMM or AAR File field must contain the full path and name of an XMM
or AAR archive. Choose the Direct Test option to use this interface.

® HTTP interface: enter the name of the URI of the running EntireX Listener for XML/SOAP.
Choose the HTTP Test option to use this interface.

3 Complete the input area:

* Type your XML document.
= Use the Create Sample XML... button and follow the dialog.

| Note: If the IDL file contains only one library with one program, this is used for the
sample generation without opening the dialog.

Example dialog;:
= XML Sample Generaticn I. EY ﬁl
Select a program from the corresponding library.
a 4 EXAMPLE
&7 CALC
&P SQUARE
(?:' [ oK ] ’ Cancel

* Load sample document, using drag-and-drop operation on the sample page of XML Mapping
Editor or file browser.
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e examplexmm 52 = B 5= Outline 2 e = ¥ = 8
4 4 EXAMPLE
XML Sample Documents =) 4 4P CALC
DL 5] XML Documents 0 " Operation (A1) In
4" Operandl () In
Fl @" EXAMPLE <%xml version="1.0" En-:c::lin:J:"'JT.F—.S".?'» ) B QP Operand2 (M) In
a P CaLC =<!-- Generated by Software AG, EntireX XML Mapping Editd 4P Function_Result (4) RESULT
= Request Document| =miCALC xminsim="urn:com-softwareag-entirex-rpaEXA. -
= 9 ~a < Operation>+</Operation> 4 @p SQUARE
|=| Response Document <Operandl >21</Operandl> 4 Operand (4) In
4 4P SQUARE \\ < Operand2>6+</0perand2> 4" Result (1) Qut
|=| Request Document e /i CALC:
\
|= Response Document \ I
[lp T EI
Overview | XML Request | XML Response | Mapping Parameters | XML Samples
\
\
Tasks )(MLTesterSZ RPC Environment |r. | = 8
\
~ Target and Environment Area 'InI it
@ HTTP Test (XML/SOAP Listener) HTTP URL '.http:_a'_a'localh05t:10010_a’w55tack.-'ser\rices -
1
() Direct Test AMM or AAR File: :DI\WDVkSPECE\aEmNE-Xmm -- -ﬁrowse...
!
r
Input XML Document: Browse...
Document Area (Request and Response) / [l;
’
Tree View | Text View | Raw View ;!
A

Requesk Document
4

Tree View | Text View | Raw View

The following tabs are available:

® The Text View tab will try to color the request syntactically, making the XML easier to
read.

® The Raw View tab is initially empty. When the first request is sent, it is filled with the

exact message sent together with information on the request method and the used HTTP
headers with their values.

® From then on the Raw View is displayed and is updated with the last sent request.

Select an existing XML document (you can use the Browse button) and enter it in the field
Input XML file to send.

If the testing interface is Java, the Settings action will open the Direct Test Details dialog.
The dialog contains the three tabs with the following settings:

" Main

® Broker Security

* Natural Security
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See Direct Test Details Dialog.
5 Ifusing option HTTP Test, the Settings action will open the EntireX’HTTP/HTTPS Parameters
dialog. The dialog contains three tabs with settings for the HTTP call:
" EntireX Parameters
= HTTP Headers
® HTTPS Parameters

See EntireX/HTTP/HTTPS Parameters Dialog.

6  Send the request by choosing action Play. If the testing interface is HT'TP, the Sending request
dialog appears. Here you have several options:

® hide the dialog by pressing Run in Background button
® cancel the request. This will terminate the session with the server

® show details about all running Eclipse jobs

A progress bar on the Eclipse status bar shows to indicate that the request is being sent.

| Tasks XML Tester &3 RPC Environment Monitor EntireX Default Broker (] g-| = O

+ Target and Environment Area

@ HTTP Test (XML/SOAP Listener) HTTP URL  http://localhost10010/wsstack/services -

() Direct Test XMM or AAR File:  Di\workspace\examplexmm --
Input XML Decument:
Ik

r

Document Area (Request and Response)
Tree View | Text View | Raw View

<%l version="1.0" encoding="UTF-8" 7=
<l-- Generated by Software AG, EntireX XML Mapping Editor (10.5.0.0) on 2018-11-21 at 08:22:53
<m:CALC xminsim="urn:com-softwareag-entirex-rpc EXAMPLE-CALC" =
< (Operation>+</Operation>
<QOperandl»21</0perandl >
<(Operand2>6+</Operand2>
</m:CALC=

4

Tree View | Text View | Raw View

"Processing .."

: EXMLTester. Sending request... [r— ]

If you used the Direct Test option, you cannot cancel the request.
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7 When a response is received, it is displayed in the output area. Errors are also displayed in
the output area.

The Text View tab displays the XML response as formatted and syntactically colored text.
The Raw View tab displays the response “as is”. Information on the used request method,
response code and HTTP headers with their values is displayed for the XML response.

Using the Broker and RPC User ID/Password

EntireX supports two user ID/password pairs: a broker user ID/password pair and an (optional)
RPC user ID/password pair sent from RPC clients to RPC servers. With EntireX Security, the broker
user ID/password pair can be checked for authentication and authorization.

The RPC user ID/password pair is designed to be used by the receiving RPC server. This compon-
ent's configuration determines whether the pair is considered or not. Useful scenarios are:

® Credentials for Natural Security

® Impersonation in the respective RPC Server documentation

" Web Service Transport Security with the RPC Server for XML/SOAP, see XML Mapping Files

" Service execution with client credentials for EntireX Adapter Listeners, see Configuring Listeners
" etc.

Sending the RPC user ID/password pair needs to be explicitly enabled by the RPC client. If it is

enabled but no RPC user ID/password pair is provided, the broker user ID/password pair is inher-
ited to the RPC user ID/password pair.

The check box Enable Natural Logon (see below) enables sending the RPC user ID/password pair
in Direct Test mode. In HTTP test mode, the HTTP parameter exx-natural-security has to be set.
If you do so, we strongly recommend using SSL/TLS. See SSL/TLS, HTTP(S), and Certificates with
EntireX.

~ To use the broker and RPC user ID/password with Direct Test mode

1  Specify a broker user ID and broker user password in the Broker Security tab.

2 Activate the Natural tab and check the check box Enable Natural Logon to enable sending
the RPC user ID/password pair.

3  If different user IDs and/or passwords are used for broker and RPC, enter RPC User 1D and
RPC User Password in the Natural tab to provide a different RPC user ID/password pair.

4 By default the library name sent to the RPC server is retrieved from the IDL file (see
Tibrary-definitionunder Software AG IDL Grammar in the IDL Editor documentation). The
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library name can be overwritten. This is useful if communicating with a Natural RPC server.
Specify a Natural library in the Natural tab.

~ To use the broker and RPC user ID/password with HTTP Test mode

1  Activate the EntireX tab.
2 Add exx-user and exx-password as EntireX parameters.

3  Add EntireX parameter exx-natural-security to enable sending the RPC user ID/password
pair.

4  If different user IDs and/or passwords are used for broker and RPC, add exx-rpc-user and
exx-rpc-password as EntireX parameters to provide a different RPC user ID/password pair.

5 By default the library name sent to the RPC server is retrieved from the IDL file (see
Tibrary-definitionunder Software AG IDL Grammar in the IDL Editor documentation). The
library name can be overwritten. This is useful if communicating with a Natural RPC server.
Specify a Natural library in HTTP parameter exx-natural-Tibrary.

Using Conversational RPC

> To use conversational RPC with HTTP Test mode

1 Open Settings.
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& XKML Tester *
EntireX/HTTP/HTTPS Parameters
Manage EntireX/HTTP/HTTPS Parameters
EntireX Parameters HTTP Headers HTTPS Parameters
Key Value Add...
Edit...
Remove
Select All
Deselect All
Add EntireX Parameters to
SOAP/XML Request Document HTTP Header
0K Cancel
2 Add key exx-conv and set value to "OPEN".
£ XML Tester X
Add new EntireX Parameter
Define key and value for the EntireX Parameter.
Key: | exx-conv ot
Value: | [0y}
@ 0K Cancel
3  Press OK.
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& XKML Tester

EntireX/HTTP/HTTPS Parameters
Manage EntireX/HTTP/HTTPS Parameters

EntireX Parameters HTTP Headers HTTPS Parameters

Key Value Add...
L] exx-conv OPEN :
Edit...
Remove
Select All
Deselect All
Add EntireX Parameters to
SOAP/XML Request Document HTTP Header
0K Cancel
4  Select exx-conv.
S XML Tester
EntireX/HTTP/HTTPS Parameters
Manage EntireX/HTTP/HTTPS Parameters
EntireX Parameters HTTP Headers HTTPS Parameters
Key Value Add...
eXx-conv OPEN )
Edit...
Remove
Select All
Deselect All
Add EntireX Parameters to
® SOAP/XML Request Document (O HTTP Header
0K Cancel
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5 Press OK.

6  Send the request.

7  The response contains the exx-xml-sessionlID used for conversational communication. This
parameter is also added to EntireX parameters for the next call(s) automatically. The parameter
exx-conv is deactivated simultaneously.

8§ <!-- snippet with exx-xml-sessionID in response document -->

<axis2nsl:EntireX xmlns:axisZ2nsl="urn:com.softwareag.entirex.xml.rt">
<{exx-xml-sessionID>XML610C044029044C05</exx-xml-sessionID>
{/axisZnsl:EntireX>
<I-- snippet -->

9  To finish the conversation, open the settings again, activate the exx-conv and set its value to
"COMMIT" or "BACKOUT".

10 The conversation is closed with the next sent call.
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4 Using the XML Mapping Editor in Command-line Mode

= Command-line Options

= Example ...vviiinnnns
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Command-line Options

See Using EntireX in the Designer Command-line Mode for the general command-line syntax. The
table below shows the command-line options for the XML Mapping Editor.

Task Command Option Description
Create SOAP-conformant XML -map:soap
mapping for all programs. -map:soapl.l Supported for compatibility

with older versions.

Create attribute-preferred XML
mapping for all programs.

-map:xmlattributes

Create element-preferred XML
mapping for all programs.

-map:xmlelements

Create element-preferred XML
mapping with XML Schema for all
programs

-map:xmlwithxsd

-namespace

If namespace is specified, the
namespace URI for the
program node. XML Schema
uses this namespace URI as the
target namespace.

Create sample XML documents for
all programs.

-xml:sample

Example

<workbench> -map:soap /Demo/example.id]l

where <workbench> is a placeholder for the actual EntireX design-time starter as described under
Using EntireX in the Designer Command-line Mode.

The generated XML mapping file (XMM) will be stored in parallel to the IDL file, for example in

project Demo.

Status and processing messages are written to standard output (stdout), which is normally set to

the executing shell window.
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IDL to XML Mapping with the XML Mapping Editor

Mapping IDL to XML Automatically .......................
Mapping IDL to XML Manually ...............ccceoennee
Defining the XML Encoding ...........ccccvveeiinneeenne.
Validity Checks ..........ccvvveeiiiiiiiiiiiicc

Generating an XML Schema from IDL-XML Mapping

47



IDL to XML Mapping with the XML Mapping Editor

The EntireX XML Mapping Editor allows you to map XML document structures to IDL libraries,
programs and parameters. The mappings can be defined for the request and response to the
server application, or from the server to the client. The input for the XML Mapping Editor can be
a Software AG IDL file and/or an IDL-XML mapping file (perhaps produced by a previous XML
Mapping Editor session or by importing a WSDL file, XML Document or XML Schema). The output
is an IDL-XML mapping file, other XML structure definitions (such as sample XML files), and
perhaps a created or changed IDL file.

There are two ways to create an IDL to XML mapping: automatically (and then modify the resulting
structures manually), or manually.

Mapping IDL to XML Automatically

= Scope

= Mappings

= SOAPAction

= Using Mapping Parameters
= Mapping Parameters

= Document Style

= Encoding Settings

= Null Value Suppression

= Namespace Definitions

Scope

The following approaches are available:

" Map all programs in the current IDL file with the element-preferred strategy.
® Map all programs in the current IDL file with the attribute-preferred strategy.

Create a SOAP mapping for all programs in the current IDL file.
® Mapping and XML Schema generation for all programs in the current IDL file. This creates an

element-preferred mapping.

The mapping strategies generate XML tree nodes for all IDL parameters with the appropriate
direction:

® For IN and INOUT IDL parameters, XML Request nodes are generated.

® For INOUT and 0UT IDL parameters, XML Response nodes are generated.

® Fault trees (Error trees) are generated, see Fault Document Manager under XML Response

Page.

Format, length and default values of the XML nodes are set according to the IDL parameter:
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In the table below, the following metasymbols and informal terms are used for the IDL.

® The metasymbols "[" and "]" enclose optional lexical entities.

* The informal term number (or in some cases numberl.number?)is a sequence of numeric characters,

for example 123.

Software AG IDL Description XML Data Type

Anumber Alphanumeric Variable-length string node with maximum
length.

AV Alphanumeric variable Variable-length string node.

length

AVLnumber] Alphanumeric variable Variable-length string node with maximum

length with maximum length |length.

Bnumber Binary binary node with length of binary representation
(base 64)

BV Binary variable length Variable-length binary node.

BVLnumber] Variable-length binary node with maximum
length.

D Date XML date node. The length depends on the
specified time pattern length. This is trimmed, and
what is included in single quotes will be counted
(without the single quotes). For example:
"T'HH:mm: s s has length=9.

F4 Floating point (small) float node of length 32.

F8 Floating point (large) float node of length 64.

I1 Integer (small) integer node of length 4.

12 Integer (small) integer node of length 6.

14 Integer (small) integer node of length 11

Knumber Kanji Variable-length string node with maximum
length.

KV Kanji variable length Variable-length string node.

KVLnumber] Kanji variable length with  |Variable-length string node with maximum

maximum length length.

L Logical Boolean node.

Nnumberll.number2] |Unpacked decimal number node. If number >0, length increased by 2,

otherwise by 1.

NUnumberl(.number?Z]

Unpacked decimal unsigned

number node. If number >0, length increased by 2,
otherwise by 1.

Pnumberll.number?Z]

Packed decimal

number node. If number >0, length increased by 2,
otherwise by 1.

PUnumberll .numberZ]

Packed decimal unsigned

number node. If number >0, length increased by 2,
otherwise by 1.
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Software AG IDL Description XML Data Type

T Time dateTime node. The length depends on the
specified time pattern length. This is trimmed, and
what is included in single quotes will be counted
(without the single quotes). For example:
yyy-MM-dd'T"HH:mm:ss has length=19.

Unumber Unicode Variable-length Unicode node with maximum
length.
uv Unicode variable length Variable-length Unicode node.
UVnumber Unicode variable length with | Variable-length Unicode node with maximum
maximum length length.

The resulting XML structures can be modified, see Mapping IDL to XML Manually.
The automatic mapping process can be fine-tuned by mapping parameters to be set before mapping.

For information on the attribute-preferred and element-preferred strategies see XML Structures
and IDL-XML Mapping in the XML/SOAP Wrapper documentation.

Mappings

For SOAP additional type attributes are generated. They describe the XML Schema compliant
data types of the elements.

SOAPAction

The SOAPAction tag in the SOAP header will be moved to the HTTP header. The SOAPAction
element is generated automatically with SOAP mapping. Verify the default setting. If SOAPAction
is missing, insert it: select the SOAPHeader node and add a new child node with the name
SOAPAction. Then select the new element node with the name SOAPAction, open the XML Details
panel and enter the value for that HTTP header into the Default attribute field. The NullValueSup-
pression property should have the value “Suppress Element”.

Using Mapping Parameters

~ To use the mapping parameters

1  Switch to the Mapping Parameters page or define the XML Mapping Editor preferences.
2 Check the check boxes, dialog boxes and complete the text fields you need.

50 EntireX XML Mapping Editor



IDL to XML Mapping with the XML Mapping Editor

Mapping Parameters

The mapping parameters are on the following sections.

Document Style

Mapping Parameters Restore DeFaults

The mapping parameters can only be used for generating a new IDL-%ML mapping.
Just changing mapping parameters has no effect on an existing mapping; generate the mapping again for the changes to take effect.

+ Document Style
Generate Array Envelope Element

WSDL Skyle: | documentliceral W

b Mull ¥alue Suppression

» Mamespace Definitions

Crverview | XML Request | XML Response | Mapping Parameters | ML Samples

Parameter Description

Generate Array Envelope Element|Determines whether for each array a surrounding additional element
(envelope) is generated or not.

WSDL Style Prepare the SOAP Mapping for selected WSDL Style. Possible values:
documentliteral or rpc/encoded.
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Encoding Settings

Mapping Parameters Restore Defaults

The mapping parameters can only be used for generating a new IDL-XML mapping.
Just changing mapping parameters has no effect on an existing mapping; generate the mapping again for the changes ko kake effect,

b Document Style

#ML Default Encoding: | UTF-3
|:| Use incoming Encoding
b Mull ¥alue Suppression

» Mamespace Definitions

Owerview | L Regquest | XML Response |Mapping Parameters | ML Samples

Parameter

Description

XML Default Encoding

This encoding is used for the sent XML/SOAP document if the box Use incoming
encoding is not checked (for XML-based clients), or if the RPC Server for
XML/SOAP is used.

Use Incoming Encoding

Check this box to enable the XML/SOAP Wrapper to use same encoding for the
incoming document as for the outgoing document.
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Null Value Suppression

Mapping Parameters Restore Defaults

The mapping parameters can only be used for generating a new IDL-%ML mapping.
Just changing mapping parameters has no effect on an existing mapping; generate the mapping again for the changes to kake effect,

b Document Style

} Encoding Settings

Control empty elements or attributes may be omitted in the ¥ML documents,

Enable Mull Yalue Suppression

Simple Element: | Mo Suppression w
Simple Attribute: | Mo Suppression w
Brray Types: Cells at End (Trim) w
Complex Types: | Suppress Group Elements s
Suppress Attributes, if Elerment has Mull Yalue
} Mamespace Definitions
Cwerview XML Request | XML Response | Mapping Parameters | %ML Samples
Parameter Description
Enable null value suppression |Switch on/off the null value suppression.
Simple Element Suppress Elements. Possible Values: No Suppression or Suppress Element.
Simple Attribute Suppress Attributes. Possible Values: No Suppression or Suppress Attribute.
Array Types Suppress Array Types. Possible Values: No Suppression, All empty cells
or Cells at end (Trim).
Complex Types Suppress Complex Types. Possible Values: No Suppression (no special
handling of complex types - null value suppression defined for 'Simple
Element' is used), or Suppress Group Elements.

For more details on null value suppression, see Null Value Suppression under Writing Advanced
Applications with the XML/SOAP Wrapper.
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Namespace Definitions

Mapping Parameters Restore Defaults

The mapping parameters can only be used for generating a new IDL-%ML mapping.
Just changing mapping parameters has no effect on an existing mapping; generate the mapping again for the changes to take effect,

b Document Style
} Encoding Settings

¥ Mull ¥alue Suppression

~ Mamespace Definitions

Table of defined Mamespace definitions:
Default

Prefix Mamespace
SOAP-ENY http:/fschemas, xmlsoap,org/soapjenvelopef

wsd hikbp: f e, w3 0rg 2001 fXMLSchema

m urn:com-softwareag-entirex-rpo s %l (default)
SCAP-ENC hittp: /{schemas. xmlsoap, org/soap/encoding)

w5 hktp: /s w3, 0rgf 2001 fMLSchema-inskance

Cweryview | ML Request | ML Response |Mapping Parameters | XML Samples

Parameter Description

Namespace Definitions Table |Manage all Namespaces with prefix and URL

New namespace definitions can be entered with Add... . To change an entry choose Edit... . All
selected entries can be deleted with the Remove button. With the Default button you mark the

Namespace used for the Payload Root node, e.g. in XML Mapping the Root Element and in SOAP
Mapping the first element in the SOAP-Body:.

The Edit dialog (and similar Add dialog) looks like:

& Edit Namespace

Mamespace; |http:Il'll'schemas.xmlsoap.Drgll'snap,l'encodingll'

oK | Cancel |

~ To map automatically with your preferred result

On the Mapping section of the Overview Page choose the preferred Mapping style and press
the Generate All button.

The various generated XML Structures can be modified, see Mapping IDL to XML Manually.
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If errors/warnings have occurred, the Validity Check window will be displayed. The errors/warnings
for all programs will be found in the Problems View. In the first line of this View you will find a
short summary of the problems. If you click on an error/warning, the XML structure for it is dis-
played with the invalid node highlighted.

@y Caution: There are rare cases when the SOAP default mapping generates warnings (for ex-

ample for IDL files with cascaded arrays). A dialog is displayed stating that illegal mappings
have been generated. The warnings mostly deal with duplicate element names. You may
ignore them as long as you do not use the mapping for WSDL or XML Schema. For details,
see the Problem View.
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Mapping IDL to XML Manually

This section covers the following topics:

= Summary of Steps

= Choosing XML Request or XML Response XML Structure
= Adding an XML Node

= Grouping XML Elements or Attributes

= Mapping an IDL Node to an XML Node

= Unmapping XML Nodes

= Deleting Nodes

= Deleting XML Structures

= Modifying the Element or Attribute Name

= Changing Elements to Attributes and Vice Versa
= Assigning Default Values

Summary of Steps

~ To map an IDL file manually to an XML structure or modify an IDL-XML mapping file

1 Choose direction (XML Request or XML Response).
2 Add/modify XML nodes.
3  Map IDL nodes to XML nodes.

Choosing XML Request or XML Response XML Structure

> To choose the XML Structure

1 Select the XML Request to get the IDL IN and INOUT Parameter Mapping.
2 Select the XML Response to get the IDL 0UT and INOUT Parameter Mapping.

Adding an XML Node

~ To create a child node to an existing (selected) XML node

1  Click on the existing node.

2 From the context menu, choose New child node.

A dialog window is displayed.
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& XML Mapping Editor

) im

ML Node Properties pu

Mew Child Mode., ..
Mew Mame: Wewharme

Mode Type

(*)Element () Attribute
[ ] Generate xml:space Attribute (Ignore other Input)

':'E‘:' | ] 4 | | iZancel

3 Enter the new node's name and type (element or attribute) and use OK.

~ To insert a new node before or after an existing (selected) XML node

1 From the context menu, choose Insert before or Insert after, respectively.

A dialog window is displayed.

2 Enter the new node's name and type (element or attribute) and use OK.

Note that new attribute nodes do not have a format, length and default property assigned. You
must assign at least a format to the node before saving the mapping file. See Direct Test Details
Dialog. Use the Validity Checks to make sure that all nodes have the necessary properties.

Grouping XML Elements or Attributes

You can introduce new elements by grouping one or more existing elements or attributes. See also
XML Structures and IDL-XML Mapping in the XML/SOAP Wrapper documentation.

~ To group XML elements or attributes

= Add anew XML part and move the existing nodes into the new node.

You can use cut-and-paste or a drag-and-drop operation to reorder the XML parts. Four move
functions are available in the XML context menu: Bring to top, Bring to bottom, Move up, Move
down, which are equivalent to drag-and-drop operation. See Using the Context Menu and Using
Drag-and-drop.
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Mapping an IDL Node to an XML Node

> To add (or modify) an IDL-XML node mapping link

1

Click into the Mapped to field in the XML Node Properties Dialog.

A dialog displays the possible IDL mapping links.
Choose one of the menu items to map the IDL node to the XML node.

If the XML node had a previous IDL mapping link, it is released.
Or:

Use a drag-and-drop operation to move the IDL node to be mapped directly to the XML node.
If the XML node had a previous IDL mapping link, it is released. See Using Drag-and-drop.

Or:

Use the keyboard to tab into the Mapped to text field, and press Enter. This will open the dialog
Mapped to. Select a mapping link from the list and use the OK button to confirm. Use the
Cancel button to cancel the action.

IDL-XML mapping uses the full path notation. This notation is a slash-separated list of IDL node
names, starting with the program name, ending with the addressed IDL node, and containing all
IDL nodes between program and the IDL node (the path from the program name to the node).

~ To modify the format of the XML node

Select an entry from the dialog box in the XML Node Properties Dialog.

The dialog box contains the possible format values. You cannot add new format codes.

Unmapping XML Nodes

~ To unmap XML nodes

1
2

Select one or more XML nodes mapped to IDL node(s).

From the context menu, choose Unmap.

This will unlink the IDL and XML nodes.
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Deleting Nodes

> To delete arbitrary elements or attributes

1  Select the node(s) to delete.

2 From the context menu, choose Delete. If nodes have descendants, the following window is
displayed:

& Delete

The Mode Body contains descendant Modes, Do yvou want to delete them as
““J"} well?

3  To delete the subtree attached to the node, choose Yes.

4  To keep the elements of the subtree and move them one level higher, choose NO.

@ Caution: If IDL nodes are not mapped in the incoming XML request, the result for the runtime

component is that the corresponding IDL parameters are filled with zero strings.

Deleting XML Structures

~ To delete the complete IDL to XML mapping (all XML Structures)

= In the mapping menu, choose the item New mapping for all programs.

~ To delete the currently selected XML Structures
= In the mapping menu, choose the item New mapping.
Modifying the Element or Attribute Name

In the automatically mapped structures the XML node names are built from the IDL parameter
names.

~ To change the node name

s Choose Rename from the context menu.
Or:

Double-click on the name field in the XML Node Properties Dialog.
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To avoid accidental changes, there is no other way to modify the name.

When the name of an XML part is modified, various checks of the XML structure are performed,
e.g. attribute name duplication, IDL mapping legality. The IDL-XML-mapping link is not influenced
by the name change.

Changing Elements to Attributes and Vice Versa

You have the possibility to switch the node type between element and attribute. Note that attributes
may not have descendant nodes and namespace definitions.

> To switch between elements and attributes

s From the context menu, choose Set to Element and Set to Attribute.
This function works for multiple nodes, too.

A\  Important: Arrays must always be modelled with elements.

Assigning Default Values

Every XML part can contain default values in case elements are missing in the incoming XML
document.

> To set the default values

s Inthe XML Node Properties Dialog, enter a Default Value.
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Defining the XML Encoding

~ To define default encoding for IDL to XML mapping

1  Open the IDL properties and choose the XML tab

Preferences M=l E3

Itype filker best

- Java Persistence -
-- Jawascripk I
B 150N

-- Maven

Myhven

Comph

Plug-in Development

Remote Svskems

|- Feun/Debug

- Server

- Software AG

- APT-Portal

- Document Expansion

[=1- Entirex

[+]- COBOL

- Inkegration Servers

H-PLIT

[=]- Web Services

‘. RPC Enwironments Far RF
- \Web Service Wrapper
... ¥ML Mapping Editar

[+]- W'rappers

- External Toals

- Inkegration Servers

- Service Development

- UDDI Registries

[+ Web Services Stack.

I+l
L

XML Mapping Editor = - -

Store Settings for XML Mapping and =ML Schema Generation.

Document Setting I Namespaces I Mull Walue Suppression | #ML Schema Generation I
Document Style
¥ Generate Array Envelope Element

WSDL Skyle: Idocumentfliteral

Encoding Settings
*¥ML Default Encoding:

|uTF-8
v Use incoming Encoding

Default Pattern for Date/DateTime Format
| sy -pME-dd
E.g.: 2018-Feb-28.
Patkern Datetime Format: | iy -PMMM-dd T'HH: mm: s
E.q.: 2018-February-26T10:16: 36,

Local For DaterpateTine: [ - |

¥ Generate WSDL with patkern attribute For Date/DateTime Format

Pattern Date Format:

{ - \Workspace Indelx Llll Restore Defaultsl Apply |
(’?} |@:| (@j K I Cancel |

2 Modity the Encoding Settings section:

® For scenarios with the Listener for XML/SOAP:

= XML Default Encoding (default: UTF-8)
This is the encoding that will be used to write the mapping file itself. If Use incoming
Encoding is disabled, this encoding will be used for the response documents.
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= Use incoming Encoding (default: checked)
If this check box is checked, the same encoding of the incoming document will be used
for the response documents. The XML Default Encoding is not used.

* For scenarios with the RPC Server for XML/SOAP:

® XML Default Encoding (default: UTF-8)
This is the encoding that will be used to write the mapping file itself. This encoding will
be used for the outgoing XML documents.

* Use incoming Encoding
Not used.
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Validity Checks

The Validity check is automatically performed for automatic mapping and when an existing IDL-
XML mapping file is opened, but can also be performed manually.

The following validity checks are available:

1. Checks that all elements have unique tags - produces warnings
2. Checks that all attributes of an element have unique names (mandatory)

3. Checks that the generated XML parts have correct property values (mandatory), e.g. minimum
occurrences less than or equal to maximum occurrences

4. Checks that the IDL mapping is valid (mandatory) and the IDL parameters are not mapped to
multiple XML parts (warning)

5. Checks that all IDL parameter nodes are mapped to one or more XML parts, (so that the runtime
component finds XML values for all IDL parameters or vice versa) (warning)

The first four of the checks apply to XML tree nodes, that is, search for invalid settings or mapping
rules of XML elements or attributes. The fifth check applies to the IDL tree.

The check messages may be divided into warnings (message text starts with (W)) and errors.
Warnings can even be caused by automatic mapping. Generally, they can be ignored. Errors should
not be ignored.
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Generating an XML Schema from IDL-XML Mapping

~ To save the XML structure tree as an XML Schema (XSD) document

= An XML Schema can be generated from the current XML Mapping using the context menu
of the XMM file. The XML Schema style "Russian Doll" or "Venetian Blind" can be selected in
the preferences.

See Mapping IDL Data Types to an XML Schema (XSD) for mapping of IDL data types to XSD.

See also XML Schema Parser Standards Conformance and XML Schema Writer Standards Conformance
under XML Schema Standards Conformance (XML/SOAP Wrapper) in the XML/SOAP Wrapper

documentation.
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In the table below, the following metasymbols and informal terms are used for the IDL.

® The metasymbols "[" and "]" enclose optional lexical entities.

* The informal term number (or in some cases numberl.number?)is a sequence of numeric characters,

for example 123.

IDL Data Type Description XMM XSD
Anumber Alphanumeric string <{xsd:element name="name" form="unqualified">
<xsd:simpleType>
<xsd:restriction base="xsd:string">
<xsd:maxlLength value="number"/>
{/xsd:restriction>
</xsd:simpleType>
</xsd:element>
AV Alphanumeric string <xsd:element name="name" form="unqualified">
variable length {xsd:simpleType>
<xsd:restriction <
base="xsd:string"></xsd:restriction>
</xsd:simpleType>
</xsd:element>
AVLnumber] Alphanumeric |string <{xsd:element name="name" form="unqualified">
variable length {xsd:simpleType>
with <{xsd:restriction base="xsd:string">
maximum {xsd:maxlLength value="number"/>
length <{/xsd:restriction>

</xsd:simpleType>
{/xsd:element>
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IDL Data Type

Description

XMM

XSD

Bnumber

Binary

binary

<xsd:element name="name" form="unqualified">
<xsd:simpleType>
{xsd:restriction base="xsd:base64Binary">
{xsd:length value="baseb4Length"/>
</xsd:restriction>
</xsd:simpleType>
<{/xsd:element>

Note: base64Length=4*rounded up(number /3)

BV

Binary
variable length

binary

<xsd:element name="name" form="unqualified">
<xsd:simpleType>

{xsd:restriction <«
base="xsd:baseb4Binary"></xsd:restriction>
</xsd:simpleType>
{/xsd:element>

BV nhumber]

Binary
variable length
with
maximum
length

binary

{xsd:element «

name="name" form="unqualified"> «

<xsd:simpleType>

<{xsd:restriction base="xsd:base64Binary">
<xsd:maxLength value="base64Length"/>
</xsd:restriction>

</xsd:simpleType>

</xsd:element>

Note: base64Length=4"*rounded up(number /3)

Date

date:yyyy-MM-dd

<xsd:element name="name" form="unqualified">
<xsd:simpleType>

{xsd:restriction <«
base="xsd:date"></xsd:restriction>
</xsd:simpleType>
</xsd:element>

F4

Floating point
(small)

float

<xsd:element name="name" form="unqualified">
<xsd:simpleType>

{xsd:restriction «
base="xsd:float"></xsd:restriction>
</xsd:simpleType>
</xsd:element>

F8

Floating point
(large)

float

<xsd:element name="name" form="unqualified">
<xsd:simpleType>

<xsd:restriction «
base="xsd:double"></xsd:restriction>
</xsd:simpleType>
</xsd:element>
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IDL Data Type Description XMM XSD

Il Integer (small) |integer <xsd:element name="name" form="unqualified">
{xsd:simpleType>
{xsd:restriction base="xsd:byte">
{xsd:totalDigits value="3"/>
{xsd:fractionDigits value="0"/>
<{/xsd:restriction>
</xsd:simpleType>
</xsd:element>

12 Integer integer <xsd:element name=" name" <

(medium) form="unqualified">

<xsd:simpleType>
{xsd:restriction base="xsd:short">
{xsd:totalDigits value="5"/>
<xsd:fractionDigits value="0"/>
</xsd:restriction>

</xsd:simpleType>

</xsd:element>

14 Integer (large) |integer <{xsd:element name=" name" <
form="unqualified">
<xsd:simpleType>
<xsd:restriction base="xsd:int">
{xsd:totalDigits value="10"/>
<{xsd:fractionDigits value="0"/>
</xsd:restriction>
</xsd:simpleType>
</xsd:element>

Knumber Kanji string <{xsd:element name=" name" <
form="unqualified">
<xsd:simpleType>
{xsd:restriction base="xsd:string">
<{xsd:maxLength value="number"/>
</xsd:restriction>
</xsd:simpleType>

{/xsd:element>

KV Kanji variable |string <xsd:element name=" name" <
length form="unqualified">

<xsd:simpleType>

{xsd:restriction <
base="xsd:string"></xsd:restriction>
</xsd:simpleType>

{/xsd:element>
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IDL Data Type

Description

XMM

XSD

KV[number]

Kaniji variable
length with
maximum
length

string

<{xsd:element name="name" <
form="unqualified">

<xsd:simpleType>
{xsd:restriction base="xsd:string">

<{xsd:maxLength value="number"/>

{/xsd:restriction>
</xsd:simpleType>

{/xsd:element>

Logical

boolean

<xsd:element name="name" form="unqualified">
<xsd:simpleType>

{xsd:restriction <«
base="xsd:boolean"></xsd:restriction>
</xsd:simpleType>
</xsd:element>

Nnumberll .numberZ]

Unpacked
decimal

numeric

<xsd:element name="name" form="unqualified">
{xsd:simpleType>
{xsd:restriction base="xsd:decimal">
{xsd:totalDigits value="numberl <«
+ number2"/>
<{xsd:fractionDigits value="number2"/>
</xsd:restriction>
</xsd:simpleType>
{/xsd:element>

Note: default of number?2is 0.

NUnumberlI(.number?Z]

Unpacked
decimal
unsigned

numeric

<xsd:element name="name" form="unqualified">
<xsd:simpleType>
<xsd:restriction base="xsd:decimal">
<{xsd:totalDigits value="numberl <
+ number2" />
<{xsd:fractionDigits value="number2"/>
<{/xsd:restriction>
</xsd:simpleType>
{/xsd:element>

Note: default of number?2is 0.

Pnumberll .number?Z]

Packed
decimal

numeric

<xsd:element name="name" form="unqualified">
<xsd:simpleType>
{xsd:restriction base="xsd:decimal">
<{xsd:totalDigits value="numberl <
+ number2" />
{xsd:fractionDigits value="number2"/>
<{/xsd:restriction>
</xsd:simpleType>
{/xsd:element>

Note: default of number?2is 0.
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IDL Data Type

Description

XMM

XSD

PUnumberll .number?]

Packed
decimal
unsigned

numeric

<xsd:element name="name" form="unqualified">
{xsd:simpleType>
{xsd:restriction base="xsd:decimal">
{xsd:totalDigits value="numberl <«
+ number2"/>
<{xsd:fractionDigits value="number2"/>
</xsd:restriction>
</xsd:simpleType>
{/xsd:element>

Note: default of number?2is 0.

Time

dateTime:yyyy-

MM-dd'T'H:mm:ss

<xsd:element name="name" form="unqualified">
<xsd:simpleType>
{xsd:restriction <«
base="xsd:dateTime"></xsd:restriction>
</xsd:simpleType>
{/xsd:element>

Unumber

Unicode

unicode

<xsd:element name="name" form="unqualified">
<xsd:simpleType>
<xsd:restriction base="xsd:string">
<{xsd:maxLength value="number"/>
<{/xsd:restriction>
</xsd:simpleType>
<{/xsd:element>

uv

Unicode
variable length

unicode

<xsd:element name="name" form="unqualified">
<xsd:simpleType>

<xsd:restriction <«
base="xsd:string"></xsd:restriction>
</xsd:simpleType>
<{/xsd:element>

UVnumber

Unicode
variable length
with
maximum
length

unicode

<xsd:element name="name" form="unqualified">

<xsd:simpleType>
{xsd:restriction base="xsd:string">
<{xsd:maxLength value="number"/>
</xsd:restriction>

</xsd:simpleType>

</xsd:element>
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Mapping IDL Data Types to WSDL Data Types

The generation of WSDL depends on the option Generate simple types under Preferences >
Software AG > EntireX > Web Services > Web Service Wrapper > Mapping.

[ prete o e ] |
= Preferences - _—
type filter text Web Service Wrapper L=l -
> Run/Debug . -
. Server XML Runtime| Mapping| WSDL i
4 Software AG The WSDL style is managed on the Preferences page XML Mapping Editor’,
. Ajax Devel
i AJ:IXP::;DPE' The namespace URI for prefixed root element is managed on the Preferences page XML Mapping Editor’.
. Business Services [7] Make XML schema element names unique
> Code Generation | [WE =
> Construct -
Document Expansion [] Configure connection and security
4 EntireX E Connection and Security Parameters
» COBOL
. User ID:
Integration Servers
> Matural Passwaord:
» PLT
a Web Services RPC User ID:
RPC Environments for RPC § RPC Password:
Web Service Wrapper
XML Mapping Editor Natural Library:
> Wrappers - _ s - =
a | = = b ] [ »
(?3' @) [ oK l ’ Cancel l

® If Generate simple types is checked, the description is extended by xsd:simpleType definition
if more detailed information such as length or format is available for an element.

= If this option is not checked, an element is represented with name and type; no further information
is available.

In the table below, the following metasymbols and informal terms are used for the IDL.

® The metasymbols "[" and "]" enclose optional lexical entities.

® The informal term number (or in some cases numberl.number?)is a sequence of numeric characters,
for example 123.
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WSDL (Generate simple types not

IDL Data Type |Description | XMM WSDL (Generate simple types Checked) Checked)

Anumber Alpha-  |string <{xsd:element name="name"> {xsd:element name="name"
numeric <xsd:simpleType> type="xsd:string"/>

<xsd:restriction <
base="xsd:string">

{xsd:maxLength <
value="number"/>

</xsd:restriction>
{/xsd:simpleType>
</xsd:element>

AV Alpha-  |string {xsd:element name="name" {xsd:element name="name"
numeric type="xsd:string"/> type="xsd:string"/>
variable
length

AVLnumberl|Alpha-  |string <{xsd:element name="name"> <{xsd:element name="name"
numeric {xsd:simpleType> type="xsd:string"/>
variable <{xsd:restriction <
length base="xsd:string">
with {xsd:maxlLength value=" <
maximum number "/>
length {/xsd:restriction>

</xsd:simpleType>
</xsd:element>

Bnumber Binary binary <{xsd:element name="name"> <{xsd:element name="name"

<xsd:simpleType> type="xsd:base64Binary"/>
<xsd:restriction <
base="xsd:base64Binary">
<{xsd:length <
value="baseb4Length"/>
</xsd:restriction>
</xsd:simpleType>
</xsd:element>
Note: base64Length=4*rounded
up(number [3)

BV Binary  |binary <{xsd:element name="name" <{xsd:element name="name"
variable type="xsd:base64Binary"/> type="xsd:base64Binary"/>
length

BV[number]|Binary  |binary <{xsd:element name="name"> <{xsd:element name="name"
variable <xsd:simpleType> type="xsd:base64Binary"/>
length {xsd:restriction <«
with base="xsd:base64Binary">
maximum <xsd:maxlLength «
length value="baseb4lLength"/>

</xsd:restriction>
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WSDL (Generate simple types not

IDL Data Type |Description | XMM WSDL (Generate simple types Checked) Checked)
</xsd:simpleType>
{/xsd:element>
Note: baseb64length=4* rounded
up(number [3)
D Date date:yyyy- [<xsd:element name="name"> {xsd:element name="name"
MM-dd <xsd:simpleType> type="xsd:date"/>
{xsd:restriction <
base="xsd:date">
{xsd:pattern <
value="[0-91{4}-
©
((0[1-91)|(100121))-((0L1-9])|
([12100-91)| (3[0110)"/>
{/xsd:restriction>
</xsd:simpleType>
<{/xsd:element>
F4 Floating |float {xsd:element name="name" {xsd:element name="name"
point type="xsd:float"/> type="xsd:float"/>
(small)
F8 Floating |float <{xsd:element name="name" <{xsd:element name="name"
point type="xsd:double"/> type="xsd:double"/>
(large)
Il Integer  |integer <xsd:element name="name" <xsd:element name="name"
(small) type="xsd:byte"/> type="xsd:byte"/>
12 Integer  |integer {xsd:element name="name" <{xsd:element name="name"
(medium) type="xsd:short"/> type="xsd:short"/>
14 Integer  |integer <{xsd:element name="name" <{xsd:element name="name"
(large) type="xsd:int"/> type="xsd:int"/>
Knumber Kanji string <{xsd:element name="name"> {xsd:element name="name"
<xsd:simpleType> type="xsd:string"/>
{xsd:restriction <
base="xsd:string">
{xsd:maxLength <
value="number"/>
{/xsd:restriction>
</xsd:simpleType>
</xsd:element>
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WSDL (Generate simple types not

IDL Data Type |Description | XMM WSDL (Generate simple types Checked) Checked)

KV Kanji string {xsd:element name="name" {xsd:element name="name"
variable type="xsd:string"/> type="xsd:string"/>
length

KVLnumber]|Kanji string <{xsd:element name="name"> <{xsd:element name="name"
variable <xsd:simpleType> type="xsd:string"/>
length {xsd:restriction <«
with base="xsd:string">
maximum <xsd:maxLength <
length value="number"/>

</xsd:restriction>
</xsd:simpleType>
</xsd:element>

L Logical |boolean <{xsd:element name="name" <{xsd:element name="name"

type="xsd:boolean"/> type="xsd:boolean"/>

Nnumberl |Unpacked|numeric |<{xsd:element name="name"> <xsd:element name="name"

[.numberZ2]|decimal {xsd:simpleType> type="xsd:decimal"/>

<{xsd:restriction <
base="xsd:decimal">
{xsd:totalDigits «
value="numberl + number2"/>
<{xsd:fractionDigits <«
value="number2"/>
<{/xsd:restriction>
</xsd:simpleType>
<{/xsd:element>
Note: default of number?Zis 0.

NUnumberl |Unpacked|numeric |<xsd:element name="name"> {xsd:element name="name"

[.number?2]|decimal <xsd:simpleType> type="xsd:decimal"/>
unsigned <xsd:restriction <«

base="xsd:decimal">
{xsd:totalDigits <
value="numberl + numberZ2"/>
<xsd:fractionDigits «
value="number2"/>
<{/xsd:restriction>
</xsd:simpleType>
{/xsd:element>

Note: default of number?2is 0.
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IDL Data Type

Description

XMM

WSDL (Generate simple types Checked)

WSDL (Generate simple types not
Checked)

Pnumberl
[.numberZ]

Packed
decimal

numeric

<{xsd:element name="name">
<xsd:simpleType>
<{xsd:restriction <
base="xsd:decimal">
{xsd:totalDigits «
value="numberl + numberZ2"/>
<{xsd:fractionDigits <«
value="number2"/>
</xsd:restriction>
</xsd:simpleType>
<{/xsd:element>

Note: default of number?2is 0.

<{xsd:element name="name"
type="xsd:decimal"/>

PUnumber]l
[.number?]

Packed
decimal
unsigned

numeric

<{xsd:element name="name">
<xsd:simpleType>
{xsd:restriction <«
base="xsd:decimal">
<{xsd:totalDigits «
value="numberl + numberZ2"/>
<{xsd:fractionDigits <
value="number2" />
</xsd:restriction>
</xsd:simpleType>
{/xsd:element>

Note: default of number?2is 0.

<{xsd:element name="name"
type="xsd:decimal"/>

Time

dateTime
Yyyy-
MM-dd
'T'H:mm:ss

{xsd:element name="name">
<xsd:simpleType>
<{xsd:restriction «
base="xsd:dateTime">
{xsd:pattern <«
value="[0-91{4}-((0[1-91) |
(100121))-((0[1-91)| <
([12100-91) |
(3[011))TCCL01IL0-9]) |
(2[0-3]1))(:[0-5]1[0-9]) <
{ey"/>
</xsd:restriction>
</xsd:simpleType>
{/xsd:element>

{xsd:element name="name"
type="xsd:dateTime"/>
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WSDL (Generate simple types not
IDL Data Type |Description | XMM WSDL (Generate simple types Checked) Checked)
Unumber Unicode |unicode <{xsd:element name="name"> <{xsd:element name="name"
<xsd:simpleType> type="xsd:string"/>
<{xsd:restriction <
base="xsd:string">
{xsd:maxLength <
value="number"/>
{/xsd:restriction>
{/xsd:simpleType>
<{/xsd:element>
uv Unicode |unicode <{xsd:element name="name" <{xsd:element name="name"
variable type="xsd:string"/> type="xsd:string"/>
length
UVnumber |Unicode |unicode <{xsd:element name="name"> <{xsd:element name="name"
variable <xsd:simpleType> type="xsd:string"/>
length {xsd:restriction <«
with base="xsd:string">
maximum {xsd:maxlLength <«
length value="number"/>
</xsd:restriction>
</xsd:simpleType>
<{/xsd:element>

Default Namespace

The Default Namespace used by Web Services Wrapper and the XML Mapping Editor is set to
“Urn:com-softwareag-entirex-rpc:%1-%p”,

where %1 is replaced by the IDL library name, and

%p is replaced by the IDL program name

If another namespace is required

® Change the setting on Preferences page of XML Mapping Editor.
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-
Prefe ’ )=
& Preferences .
type filter text XML Mapping Editor - T
Software AG
40 _are i Store Settings for XML Mapping and XML Schema Generation.
> Ajax Developer
API-Portal Document Setting | Namespaces | Null Value Suppression | XML Schema Generation|
> Business Services Namespace Definitions
I » Code Generation Table of defined Namespace definitions:
> Construct -
Prefi N Default Insert..,
Document Expansion — B et L= nES o u
4 Entirex im urn:com-softwareag-entirex-rpe: %l-%p (default) Edit
. COBOL | SOAP-ENC  http://schemasxmlsoap.org/soap/encodin..
Integration Servers 3 SOAP-ENV  http://schemasxmlsoap.org/soap/envelop... Remaove
. Matural xsd http:/fwwww3.org/2001/XML5chema —
. LI - xsi https/Awww.w3.0rg/2001/XMLS chema-inst.. Sk
a4 Web Services
RPC Environments for RPC §
Web Service Wrapper
XML Mapping Editor
> Wrappers s
- l%l . ’Restore Defaults] ’ Apply ]
® [ QK J ’ Cancel ]

® Change the setting on tab Overview in the XML Mapping Editor before generating the XML

Mapping File or creating the web service.

[zl *examplesmm 52 =
Overview

b General Information

w Mapping Parameters
Subset of available Mapping Parameters, To get the full list, follow the Link below or choose the Mapping Parameter page directly.

Namespace URL  urn:com-softwareag-entirex-rpc:%l-%p
[¥] Enable Mull Value Suppression
(it Mapping Parameters Get the full list of Mapping Parameters

Set current null value suppression setting to all mappings: | Update Null Value Suppression

» Mapping
+ Testing

» Validation

Owerview | XML Request | XML Response | Mapping Parameters | XML Samples

»

m

1
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Min/Max Occurrence

minOccurs/maxOccurs in WSDL

The attributes for minOccurs and maxOccurs are only presentin WSDL if the value is not the default
value (default = 1). This means that for disabled null value suppression, the attribute minOccurs
does not appear in WSDL.

minOccurs/maxOccurs for Arrays

The value of minOccurs is set to zero (by default) for request and response if null value suppression
for arrays is disabled (= "No Suppression"). You can change this setting globally in the Preferences.

XML Mapping Editor L=l v w

Store Settings for XML Mapping and XML Schema Generation.

| Document Setting | Namespaces || Mull Value Suppression || XML Schema Generationl

MNull Value Suppression
Enable Mull Value Suppression

Simple Element: [No Suppression v]
Simple Attribute: [No Suppression v]
Array Types: [Cells at End (Trim) v]
Minirnum Qccurrences for Array Nodes:
XML Request: [0 v]
XML Response: [0 v]
Complex Types: [Suppress Group Elements v]

Suppress Attributes, if Elerment has Null Value

Restore Defaultsl ’ Apply ]

Default Service Name

The default of service name is IDL file name. The service name can be changed in the Web Services
Wrapper Wizard.
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